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Disclaimer
Information in this document is subject to change without notice and does not
represent a commitment on the part of Software Bisque. The software and/or
databases described in this document are furnished under a license agreement or
nondisclosure agreement. They may be used or copied only in accordance with the
terms of the agreement. It is against the law to copy the software on any medium
except as specifically allowed in the license or nondisclosure agreement. The
purchaser may make one copy of the software for backup purposes.
No part of this product may be reproduced or transmitted in any form or by any
means, electronic or mechanical, including (but not limited to) photocopying,
recording, or information storage and retrieval systems, for any purpose other
than the purchaser's personal use, without the express written permission of
Software Bisque.
Copyrights
TheSky6 includes routines from Astronomical Algorithms Software, © 1991 by
Jeffrey Sax, and option to the book Astronomical Algorithms by Jean Meeus
copyright © 1991 by Willmann-Bell. ISBN 0-943376-35-2. Non-exclusive use has
been specifically granted, in writing, by Willmann-Bell, for use in TheSky6. Serial
Number U11A445.
Photographs in the AAO folder of TheSky6’s media are copyright © AngloAustralian Observatory (AAT images) and/or © ROE/AATB (UK Schmidt
Telescope images) and are reproduced with permission. Photographs from the
Anglo Australian Observatory telescopes are by David Malin.
The photograph of the Milky Way is licensed from Digital Sky LLC.
Copyright © 1984–2004 Software Bisque, Inc. All rights reserved.
Software Bisque, Inc.
912 12th Street
Golden, CO 80401
USA
http://www.bisque.com
Trademarks
AutomaDome™, CCDSoft™ Image Processing Software, Orchestrate™ Scripting
Software, TheSky6™, and TPoint™ Telescope Pointing Analysis Software for
Windows are trademarks of Software Bisque, Inc.
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Windows™ is a trademark of Microsoft Corporation.
All other product names are trademarks of their respective owners and are used
solely for identification.
Revision Date: July 2004
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Welcome!
Thank you for purchasing TheSky6™! No other astronomy software offers as much
power, versatility and expandability. Whether you’re just getting started or a
seasoned professional, TheSky6 has many features to help you increase the
enjoyment of your hobby.
This document introduces many new features in TheSky6, and helps you get the
software installed and running on your computer. Detailed information is available
in TheSky6 User’s Guide and in TheSky6’s Help. See Going Further on page 16 for
details about accessing these additional resources.
You can use TheSky6 to:

















Learn basic astronomy concepts.
See “what’s up” in your back yard tonight.
Print custom star charts for “in the field” use.
Go back or forward in time to see the sky (like, say, how it looked on the
day you were born).
Access astronomical catalogs with up to a billion objects.
Plan your observing sessions.
See the phase of the moon.
Find out when the next solar or lunar eclipse takes place.
Move around a three dimensional view of the solar system.
Watch a slide show of fascinating astronomical pictures.
View simulations of astronomical events.
Control your telescope.
Create custom databases of astronomical objects.
Script or automate control of TheSky6.
Generate and export custom reports of astronomical data.
Much, much more!

These features – combined with the ease-of-use of a graphical interface and the
speed of our exclusive plotting technology – provide the most-advanced
astronomy program available. TheSky6 can keep pace with your astronomical
interests, no matter how far you progress.

What’s New in this Release
TheSky6 introduces new features and major improvements. This section gives a
brief description of what’s “new and improved”. The basic operation of TheSky6 is
essentially the same as previous versions. If you’re familiar with any of them, you
can use TheSky6 right away.
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New and Improved Features of TheSky6
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Updated Location command lets you select your viewing site by clicking on
a world map, or from a list of over a thousand pre-defined sites.
New Image Manager allows you to easily add and display your own gallery
of images directly on the Virtual Sky.
Use the new Display Explorer command to control virtually every display
option in TheSky6.
New Data Wizard command allows open-ended database queries for
planning observing sessions or automated control.
Improved Field of View Indicators command lets you grow your FOVI list
with your ever-changing collection of equipment.
Field of View Indicators can be moved, copied, rotated or pinned to a
particular coordinate.
The new Time dialog box makes controlling time a snap.
Show beautiful, high-resolution Bevis constellation drawings.
Customize the local horizon using your own panoramic photographs.
Satellites move smoothly across the Virtual Sky using sub-pixel positioning.
Satellite labels are customizable and can include the satellite’s name, range
and more. The label also moves with the satellite.
Simulated sunrise and sunset glow, along with horizon shading.
The Moon and Sun incorporate simulated halos.
The display of all reference lines is smoother.
The horizon’s brightness is automatically adjusted based on the position of
the Sun.
New core stellar databases for accurate astrometry, including support for
the UCAC 2.0 and USNO B.
Support for the improved Principal Galaxy Catalog (PGC) with 900,000
galaxies.
New options allow you to select which stellar catalog you need for your
interests – charting/photometry/astrometry/historical research.
Revised, more accurate NGC and IC data from the NGC/IC project.
New, searchable and more accurate Washington Double Star (WDS) 2002
catalog even shows double star systems.
Updated and expanded variable star database (GCVS) and suspected (NSV).
Easy-to-use interface to access and view low-resolution and 100 meter per
pixel high-resolution images (TheSky6 Professional Edition only) of the
entire lunar surface from the Clementine mission, including thousands of
lunar features.
Display a Moon coordinate grid with labeled features.
Over 100,000 high-resolution photographs shown “in place” with the
correct size and position angle.
Use the right mouse button to quickly access and modify properties of all
items.
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Improved Find dialog box displays every (up to a billion and more) object in
TheSky6’s vast databases. The list includes all cross-referenced catalogs.
Right-click and drag the screen to quickly adjust the current field.
Easier stellar brightness and contrast control using keyboard accelerators.
Improved Moon Phase Calendar command shows a photograph of the
Moon’s phase for each day of the month, showing the correct orientation.
New Conjunction Finder command.
Instantly generate and display the path of any object over time.
Easily modify the location of TheSky6’s core databases using the improved
File Locations command. This feature is especially useful when installation
TheSky6 on a network (network license required).
TheSky6 now incorporates the operating system theme (look and feel) in
Windows XP.
Night Vision Mode command now changes the current theme under XP
operating systems for better control of screen colors.
TheSky6 Database Manager Command has been simplified and is easier to
use.
Stars are drawn to appear more realistic.
Galaxies and nebulae are drawn to appear more realistic.
New Help interface is easier to use.
More!

Product Editions
TheSky6 is distributed in three editions:




Student Edition
Serious Astronomer Edition
Professional Edition

Each edition includes a broad range of standard features. The Serious Astronomer
and Professional Editions include additional features for advanced astronomers.

Minimum System Requirements
TheSky6 is designed to run on the following operating systems:
·
·
·
·
·
·

Windows 98™
Windows Me™
Windows NT™ 4 (SP 6a required)
Windows 2000™
Windows XP Home™
Windows XP Professional™
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TheSky6 does not run under Windows™ 95™.
At least 200 MB of disk space is required to install TheSky6 Student Edition. Over
5 GB is required for full installation of TheSky6 Professional Edition. At least 128
MB of RAM is recommended (as always, more RAM is better), and a quad-speed
(or faster) CD ROM drive is desirable during installation.

Performance
TheSky6 is advanced, high-performance software that places substantial
performance demands on your computer.
 It is computation-intensive. It performs complex floating-point calculations
to compute the positions of sky objects.
 It is display-intensive. It updates hundreds of thousands of pixels when the
display changes.
 It is disk-intensive. It reads large amounts of data from the hard disk (or
network drive) and performs extensive cross-referencing among multiple
databases.
Version 6 of TheSky6 requires more computing power than previous versions. If
your computer can satisfactorily run Windows, it should be able to run TheSky6.
Performance with a processor slower than a 200 MHz Pentium™ (or equivalent) is
likely to be unsatisfactory.

Telescope Control Disclaimer
TheSky6 can control most commercial telescopes. Telescopes have a limited range
of movement. The telescope’s shape, the way it’s mounted, or the addition of
accessories prevents it from pointing at particular parts of the sky. If the telescope
is forced past these regions, the telescope, its mounting, or accessories might be
damaged. TheSky6 includes a “limit line” feature that lets you specify these
inaccessible positions; TheSky6 will try not to touch or cross them.
Software Bisque provides this feature as a convenience, not as a panacea. Since any
telescope can run into its mechanical limits through accident, carelessness, or
component failure, Software Bisque cannot be responsible for any damage to your
telescope that occurs when using TheSky6 to control it.
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Sun Warning
NEVER attempt to observe the Sun through your
telescope! Without a specially designed solar filter,
viewing the Sun – for even a fraction of a second – will
cause instant, irreversible eye damage. When
observing during the day, do not point the telescope
near the Sun. Do not use TheSky6’s automatic slew
feature to find objects during the day.
Children should never use a telescope during the
daytime without strict adult supervision.
After installing TheSky6, see TheSky6’s Help file (click Help | Contents and
Index) for instructions about setting up and using your telescope.

Installing TheSky6
Before starting installation please carefully read readme.htm in the root
folder of the installation media. It might have last-minute information we were not
able to put in this manual.
TheSky6 Student Edition comes on a single CD-ROM. TheSky6 Serious Astronomer
and Professional Editions are supplied on multiple CD-ROMs (or DVDs).
TheSky6 is licensed as a single-computer, single-user product – please do not
access TheSky6 over a network. If you need a site license, please contact Software
Bisque.

Installation
TheSky6 can run on the same computer as earlier versions (1, 2, 4 and 5). So,
there’s no need to uninstall earlier versions before installing TheSky6, unless you
want to save disk space.

Step 1

Put Disc 1 in the CD-ROM or DVD drive. Shortly after
loading the media, the computer should recognize its presence
and run the installation program.
If this does not occur…
1. Select Start | Control Panel (Start | Settings |
Control Panel for pre-XP operating systems).
2. Double-click Add/Remove Programs. The
Add/Remove Programs Properties dialog box appears.
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3.

Click Install, and then click Next. Windows searches
the computer’s removable drives for the program named
AutoPlay.exe and runs it. If it doesn’t find it, click
Browse and navigate to the root folder of the CD-ROM or
DVD. Double-click AutoPlay.exe.

Step 2

Click Install to begin the installation process.

Step 3

Follow the on-screen instructions to complete the installation.

The installation program prompts you for the information it needs, such as the
hard disk and folder in which to install TheSky6. The Complete/Custom
installation options are described in the following below.

Complete / Custom Installation
The choice of Complete or Custom installation controls which components that
are from the media to your hard disk.



The Complete option copies every component to the Program Files folder of
drive C. This is the recommended option.
The Custom option lets you choose the disk drive, folder and which
components are copied to the hard disk. If your hard disk not large enough
to hold all TheSky6’s databases, choose Custom and choose a disk with
more space, or check fewer options to install.

Custom Installation Options
The following options can be selected during a Custom installation.
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Program Files
Data, Databases and Pictures
Core Database Files
Hipparcos-Tycho Catalogs
Non-stellar Databases

Guide Star Catalog
UCAC 2.0
USNOB 1.0

Pictures

Solar System Pictures
Clementine Lunar Photographs
Miscellaneous Solar System Objects
Hubble Space Telescope Pictures

Anglo-Australian Observatory
Pictures
Constellation Drawings
Compressed Images
Milky Way

Image Groups
Chart Mode Metafile Symbols

Description
This component installs TheSky6’s executable and
other critical files.
Items in this group include the celestial object
databases, program data, and photographs.
The Hipparcos and Tycho stellar catalogs.
Core non-stellar catalogs, including the Principle
Galaxy Catalog (PGC), Planetary Nebulae (PLN),
New General Catalog (NGC) and Index Catalog
(IC).
Files that hold the optimized Hubble Guide Star
Catalog.
Contains the USNO CCD Astrograph Catalog
Version 2.0 (Professional Edition only)
A subset of the U.S. Naval Observatory 80 GB
stellar catalog that covers missing regions
missing in the UCAC stellar catalog. (Professional
Edition only)
Contains the low-resolution and high-resolution
(Professional Edition only) lunar photographs
from the Clementine mission.
Pictures of the planets, sun, Moon, comets, minor
planets, Apollo mission, and more.
Photographs from the Hubble Space Telescope.
(TheSky6 Student Edition on CD-ROM, Serious
Astronomer Edition on CD-ROM and Professional
Edition DVD-ROM only.)
David Malin photographs taken at the famed
Anglo-Australian Observatory. (TheSky6 Student
Edition on CD-ROM, Serious Astronomer Edition
on CD-ROM and Professional Edition DVD only.)
High- and low-resolution files containing the
Bevis constellation drawings.
100,000 Digitized Sky Survey photographs of IC,
NGC, PGC and PLN, NGC objects.
High-resolution photograph of the Milky Way.
Custom in-place color photographs of
miscellaneous deep-space objects that are
displayed on the Virtual Sky.
Vector-based symbols of objects that are used in
Chart Mode.

Troubleshooting Installation
If you’ve encountered an error during installation, check the following before
continuing.
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Temporarily disable all anti-virus software. Anti-virus software
(including spyware, adware and anti-pest software) may prevent files from
being copied to your hard drive. Once the installation is complete, don’t
forget to re-activate them.
Log on to the computer using the Administrator’s account. The
current user must have administrative privileges to install software
(Windows 2000 and Windows XP Professional only).
Delete all files and folders from the computer’s temporary folder.
The location of this folder is defined in the PATH environment variable,
and is normally named C:\Temp or C:\Windows\Temp.

Uninstalling TheSky6
By design, TheSky6 stores all user-related files in the My Documents\ Software
Bisque\TheSky6 folder. The uninstaller does not delete these files, so you do not
need to back them up before uninstalling.
Uninstalling TheSky6
1
2
3
4
5
6
7
8

Click Start | Control Panel (or Start | Settings | Control Panel for
non-XP operating systems).
Double-click Add/Remove Programs.
Highlight TheSky6 in the list box.
Click Change/Remove.
In the InstallShield Wizard dialog box, click Remove.
Click Next.
Click OK when asked if you want to completely remove the selected
application and all of its components. TheSky6 will now be deleted from
your computer.
Click OK to complete the removal.

Running TheSky6
The installation program adds TheSky6 to the Programs menu and an icon to the
Desktop. To run TheSky6, click Start | Programs | TheSky6 and then click
TheSky6’s icon. If you want TheSky6 to run automatically when you start
Windows, add TheSky6 to the Startup folder.

Logging On Your Computer
TheSky6 requires and installs software called the Microsoft .NET Framework.
After installing TheSky6, you may notice that you have to log on to your computer.
For security during installation, the .NET Framework installer creates a user
account called ASP.NET under Windows XP. This account is not malicious and
can be removed using Start | Control Panel | User Accounts.
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If you wish to remove the requirement to log on to your computer, click Start |
Run, enter the text control userpasswords2 and then click OK. Clear the
option Users Must Enter a User name and Password to Use This Machine
and then click OK.

Tip of the Day
Every time TheSky6 runs it displays the Tip of the Day, a hint about how to use
TheSky6, or information about some feature you might have overlooked. Click the
Next Tip button to see more tips.
If you don’t want to see the tips, clear the Show Tips on Start-up checkbox. You
can still read the tips by selecting the Tip of the Day command from the Help
menu.
The tips are in tips.txt, in your My Documents\Software
Bisque\TheSky6 folder. You can edit this file with any text editor (such as the
Windows Notepad) to add, delete, or modify tips. The “tip” shown above was
created this way.

Getting Started
The rest of this section is a brief overview of TheSky6. We suggest working
through it to get a feel for the program. You can then read the user’s manual, help
file, or experiment on your own.

Setting the Time and Location

Figure 1 - Time dialog box.

TheSky6 is often used to preview what you
expect to see in tonight’s sky. The program
therefore needs to know your terrestrial
coordinates. These are set using the
Location dialog box (click Data | File
Locations). You can select from a list of
predefined locations, or from a map of the
earth, or enter any set of coordinates.
TheSky6 also needs to know the time to
display the heavens. You can choose a
specific time, or let the display follow the
computer’s clock, updating in real time. Click
Data | Time to display the Time dialog box.
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Orienting the Virtual Sky
The first time TheSky6 runs, it comes up with the Virtual Sky in “Zenith Up”
mode, looking south. By default, it displays the following objects and labels.

Figure 2 – The Virtual Sky





The Sun, Moon, planets, the photographic Milky Way, and many deepspace objects.
The local horizon.
The “common” names of comets, non-stellar and Messier objects.

The Virtual Sky can be oriented in many ways, using different map
projections.

Scrolling the Virtual Sky
You can scroll the display to see a part of the sky that isn’t currently visible.
The directional arrows on the keyboard are one way to scroll. Try buttons in the
Orientation toolbar. Or right-click and drag the screen.

Changing the Field of View
The Virtual Sky is initially set to a 100° field of view. This is roughly the field of
view of the human eye. You can change the display to a wider or narrower field.
14
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The easiest way is the “magnifying glass” buttons in the Orientation toolbar. Try
clicking them to see what happens.

Moving to Specific Sky Coordinates
The arrow keys provide only a coarse positioning of the Virtual Sky. The “Move
To” command (click Orientation | Move To) lets you position the center of the
display at exactly the altitude/azimuth or right ascension/declination coordinates
you want.

Object Information
TheSky6 can display information about any celestial object in the Virtual Sky. All
you have to do is click on the object. The selected object is marked with a bull’s
eye and information about the object appears in the Object Information dialog box.
Information about the Andromeda galaxy (M31) is shown below. To display more
information, click the button with the double down arrows.

Figure 3 – The small and large Object Information dialog boxes

When you click the mouse on the Virtual
Sky, up to 10 objects “near” the mouse
pointer are displayed on the Object
Information dialog box. If the object
you’re after does not appear at the top of
the list, drop down the Object list box to
select it (see Figure 4).
If no objects are found near the mouse
pointer, information about the current
cursor position is displayed.
Figure 4 - Multiple objects.

Finding Objects
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You don’t have to locate an object in the Virtual Sky to get information about it.
The Find command can locate every object in TheSky6’s databases.
The Find command is in the Edit menu. You can also access it by pressing the
binocular button on the Object toolbar.

Printing the Screen
The current display can be printed at any time. If you have a printer connected to
your computer, click File | Print, or try clicking the Print button on the Standard
toolbar.

Optimizing TheSky6’s Drawing Speed
Drawing the photographic horizon, Milky Way photograph, and the horizon glow
can be taxing on some computers and high-resolution video displays. Disabling
these features will greatly improve TheSky6’s performance. To do so, select the
Real Mode Options command on the View menu, and then clear the Horizon
Image, Horizon Glow, and Milky Way Picture options. Click the Close button to
apply these changes.

Going Further
This introduction barely scratches the surface of TheSky6’s features and functions.
There are several ways to continue your exploration.





Experiment with the program. Try anything that comes to mind. You won’t
damage the software or the computer.
Read TheSky6 User’s Guide. This document is provided as a PDF
("portable document format") file. Note that Adobe Reader must be
installed before this document can be viewed. To install the English Edition
of Acrobat Reader for Windows XP, run the AcrobatReader6.exe setup
program in the Adobe Reader folder on the TheSky6 Disc 1. Once Adobe
Reader is installed (and after TheSky6 has been installed), click Start |
Programs | TheSky6 | TheSky6 User's Manual (PDF) to view this
document. Visit Adobe’s web site (www.adobe.com) if you need a different
language or version for your operating system.
Use the Help | Contents | Index and Search command to find
information about a specific feature.

If You Need Help...
Use TheSky6’s Help menu to get additional information. 
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If you’re unfamiliar with the Windows operating system or Windows Help,
click Start | Help and Support (Windows XP) or Start | Help (Windows
98/Me/NT/2000). Use the help’s Search feature to locate specific
information.
TheSky6’s Help | Contents | Index and Search command displays the
Table of Contents, Index and Search options. Index lets you search for
specific words or topics. Search lets you search for words or phrases in all
help topics.

To get help with a specific menu command, open the menu, and then press the
DOWN arrow to highlight the command. (Don’t click on the command, or you’ll
execute it.) Then press F1.
You can also press SHIFT+F1 to turn the regular cursor into the Help cursor. (Or
click the Help button in the Standard toolbar.) Click on any button or command to
get information about it. Many dialog boxes have Help buttons that supply specific
information about the use of that dialog box.

Product Support
We have conscientiously tried to TheSky6’s documentation accurate and easy to
understand. We therefore ask that you spend a few minutes reading TheSky6’s
User Guide (PDF), or search TheSky6’s Help documentation, before contacting us.
A little research and a bit of experimenting should answer your question. If you’re
still stuck, try the following.
1.
2.
3.
4.
5.

6.

Download and install the latest release from www.bisque.com/download.
Search the TheSky6’s Help for the Update Notes topic at
www.bisque.com/help for a list of bug fixes to see if the problem you are
encountering has been fixed in an update.
Visit the Software Bisque Knowledge Base at www.bisque.com/kb to
search for known problems and solutions.
Post your question to the Software Bisque User’s Group. Visit
www.bisque.com/support for details.
If you’re still stuck, submit a technical support request to:
http://www.bisque.com/support.
Fill out and submit the technical support request form at the above web
page. Please include the exact wording of any error messages you’ve
encountered, as well as steps tried to resolve the problem.
If you do not have access to the Internet, write us at:
Software Bisque
912 Twelfth Street
Golden, CO 80401
USA
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Please include the following information.







Your version and serial number. They are displayed when you select
About TheSky6 from the Help menu.
Your operating system – Windows 98/Me/2000/XP Home/XP
Professional or other.
Your hardware configuration – the exact make and model of computer,
processor type and speed, graphics-card manufacturer and model.
The exact wording of any messages that appeared on your screen.
What you were doing when the problem occurred.
How you tried to solve the problem.

Despite our valiant efforts, there may be omissions or errors in TheSky6. If you
find any, please let us know. Software Bisque maintains a list of documentation
corrections at www.bisque.com/corrections.
Software Bisque really cares about accuracy, completeness, and usability TheSky6.
Please note that TheSky6’s feature set is open-ended; therefore, not every feature
can be addressed in a single document.
For documentation on advanced use of TheSky6, as well as tips, and tricks, are
available at www.bisque.com/thesky. If you have suggestions about improving our
software, please tell us. We do listen!

Using the Internet
You can also contact us through our web site, www.bisque.com. Click
“Comments” from the “Support” page to send a non-technical message. Besides
providing information about Software Bisque products, photos of many
astronomical objects, and links to other useful or interesting sites, our Web site
also has software updates, revised orbital elements for comets and minor planets,
and specialized deep-sky databases.
The contents and organization of the Software Bisque web site are likely to
change. Be sure to check from time to time to see “what’s new.”
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